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[bookmark: _Toc385575716][bookmark: _Toc51670921]JURISDICTION
This Administrative Order (“Order”) is issued under the authority vested in the President of the United States by Section 104(e)(5) of the Comprehensive Environmental Response, Compensation, and Liability Act (CERCLA), as amended, and Section 300.400(d)(4) of the National Oil and Hazardous Substances Pollution Contingency Plan, 40 C.F.R. § 300.400(d)(4). This authority was delegated to the Administrator of the United States Environmental Protection Agency (EPA) by Executive Order 12580, 52 Fed. Reg. 2923 (Jan. 23,1987), and further delegated to the Regional Administrator of EPA Region __ on January 18, 2017, by EPA Delegation No. 14-6, and further redelegated to [insert Regional delegation information].
This Order applies to and is binding on Respondent and its successors, heirs, and assigns.
[bookmark: _Toc51670922]DEFINITIONS
[bookmark: _Ref50391872]Terms not otherwise defined in this Order have the meanings assigned in CERCLA or in regulations promulgated under CERCLA. Whenever the terms set forth below are used in this Order, the following definitions shall apply:
“CERCLA” means the Comprehensive Environmental Response, Compensation, and Liability Act of 1980, as amended.
 “Day” or “day” means a calendar day. In computing any period under this Order, where the last day is not a working day, the period runs until the close of business of the next working day. “Working day” means any day other than a Saturday, Sunday, or federal or State holiday.
“Effective Date” means the date this Order becomes effective as provided in Paragraph 18.
“EPA” means the U.S. Environmental Protection Agency. 
[NOTE: If the Property itself is not contaminated, but it is adjacent to a facility that is contaminated, keep the next definition. If the Facility to which the Property is adjacent is a Superfund Site or proposed Superfund Site, use “Site” instead, and substitute “Site” for “Facility” throughout the Order.]
“Facility” means the facility [or: “Vessel” or “Establishment”] [insert brief description of the adjacent facility].
“Paragraph” means a portion of this Order identified by an Arabic numeral or an upper- or lower-case letter.
[bookmark: _Ref396393747]“Property” means the property [insert brief description of the property to which access is sought, e.g. legal description of the property including street address, reference to appropriate deed, citation to tax map parcel, or similar public record identifying the property, relationship, if any, to Superfund or proposed Superfund site].  “Respondent” means [insert name].
[“Site” means the _____________ Superfund Site, encompassing approximately __ acres, located at [insert address or description of location] in [insert name of City, County, State] [insert if applicable: and depicted generally on the map attached as Appendix __.]
[bookmark: _Toc51670923]FINDINGS OF FACT
[bookmark: _Ref50451996][bookmark: _Ref396393893][bookmark: _Hlk51243072][Describe how the Property, or the Facility to which the Property is adjacent, is a place where hazardous substances or pollutants or contaminants may be or have been generated at, stored at, treated at, disposed of at, transported to or from, or released to or from, or where a release of hazardous substances, pollutants, or contaminants is or may be threatened. This information is needed to support the findings in Paragraphs 12.a and 12.d.]
[Provide facts to support EPA's belief that there may be a release or threat of release of a hazardous substance or pollutant or contaminant at or from the Property or Facility. This information is needed to support the findings in Paragraph 12.d.]
[If the Property is not contaminated, but it is adjacent to a Facility that is contaminated, describe the Property’s adjacency to the contaminated Facility. This information is needed to support the finding in Paragraph 12.b.]
[Modify and supplement as appropriate: Respondent owns [controls, leases, etc.] the Property. This information is needed to support the finding in Paragraph 12.e.]
To address the release or threatened release of a hazardous substance or pollutant or contaminant at [and/or adjacent to] the Property, EPA is conducting [planning to conduct] certain response actions. These actions include [describe the activities EPA wants to conduct at the Property and their purpose. This information is needed to support the findings in Paragraph 12.g. See also 40 C.F.R. § 300.400(d).]
EPA estimates that the duration of the required entry and access will be approximately [specify approximate duration of the entry].
Despite requests from EPA, Respondent has refused to provide access for purposes of performing the response activities described above. These requests include [describe requests in detail, e.g., phone calls and letters. Describe any conditions for access that Respondent demanded. This information is needed to support the finding in Paragraph 12.h.]
[If the action must be performed quickly, explain. An example is: EPA has been ready to perform the sampling since ________, 20__, but has been prevented from so doing because of Respondent’s failure to grant access. [Describe any health/safety risks associated with Respondent’s delay.]]
[bookmark: _Toc51670924]CONCLUSIONS OF LAW AND DETERMINATIONS
Based on the foregoing Findings of Fact, [and the administrative record supporting issuance of this Order,] EPA has determined that:
[bookmark: _Ref50385173][bookmark: _GoBack]Hazardous substances as defined by Section 101(14) CERCLA, 42 U.S.C. § 9601(14) [or pollutants or contaminants as defined by Section 101(33) of CERCLA, 42 U.S.C. § 9601(33)] may be or have been generated at, stored at, treated at, disposed of at, transported to or from, or released to or from, or a release of hazardous substances [or pollutants or contaminants] is or may be threatened at the Property [Facility].
[NOTE: If Paragraph 12.a is not true for the Property, but it is true for a Facility to which the Property is adjacent, then modify Paragraph 12.a to apply to the “Facility” and include Paragraph 12.b.]
[bookmark: _Ref50385221][bookmark: _Ref50447655][The Property is adjacent to the Facility.]
 The Property is, or is adjacent to, a Facility, Vessel, Establishment, or other place or property [keep at least one of these: where a hazardous substance [or pollutant or contaminant] may be or has been generated, stored, treated, disposed of, or transported from; from or to which a hazardous substance [or pollutant or contaminant] has been or may have been released; where such release is or may be threatened; where entry is needed to determine the need for response, to identify the appropriate response, or to effectuate a response action] within the meaning of Section 104(e)(3) of CERCLA, 42 U.S.C. § 9604(e)(3).
[bookmark: _Ref50447711]EPA has a reasonable basis to believe that there may be or has been a release or threat of release of a hazardous substance [or pollutant or contaminant] at the Property [Facility].
[bookmark: _Ref50447797]Respondent owns [or controls] the Property.
Respondent is a “person” within the meaning of Section 101(21) of CERCLA, 42 U.S.C. § 9601(21).
[bookmark: _Ref50448955]Entry to the Property by EPA and its officers, employees, agents, contractors, and other authorized representatives is needed for the purposes of [keep at least one of these: inspecting and obtaining samples, determining the need for response, choosing or taking a response action, enforcing the provisions of CERCLA] at the Property [Facility].
[bookmark: _Ref50449174]Respondent has not granted EPA’s request for access to the Property [or: Respondent’s attempts to impose conditions on EPA’s access to the Property constitute a denial of access within the meaning of Section 104(e)(5)(A) of CERCLA, 42 U.S.C. § 9604(e)(5)(A), and 40 C.F.R. § 300.400(d)(4)(i)].
[bookmark: _Toc20895494][bookmark: _Toc51670925]ORDER
[bookmark: _Ref50124179][bookmark: _Hlk47358642]Based upon the foregoing Findings of Fact, Conclusions of Law and Determinations, and the administrative record supporting the issuance of this Order, EPA hereby orders Respondent to provide EPA and its officers, employees, agents, contractors, and other authorized representatives, full and unrestricted access at all reasonable times [Optional: between the hours of __and __] to the Property for the purpose of conducting response activities, including, but not limited to, [describe specific activities, e.g., performing a Remedial Investigation/Feasibility Study]. [If “designated representatives” will also need access add this: EPA [has designated / intends to designate] __________ as its representative(s) for the purpose of obtaining access to, and performing response activities at, the Property.]
Respondent shall not prevent, limit, or otherwise interfere with EPA’s access to the Property as described in Paragraph 13 or any activity described in Paragraph 13 by EPA, its officers, employees, agents, contractors, and other authorized representatives. Any interference with any activity described in Paragraph 13 shall be deemed a violation of this Order.
[Add if Respondent owns the Property: If Respondent conveys the Property, or agents, heirs, successors and assigns, convey an interest in the Property, Respondent or Respondent’s agents, heirs, successors and assigns shall convey the interest in a manner which ensures continued access to the Property by EPA and its authorized representatives for the purpose of carrying out the activities pursuant to this Order. Any such conveyance must restrict the use of the Property so that the transferee’s use will not interfere with EPA’s access as described in Paragraph 13. Respondent, or Respondent’s agents, heirs, successors and assigns must notify EPA under Paragraph 26 at least 30 days before the conveyance of any interest in the Property, and must, prior to the transfer, notify the other parties involved in the conveyance about this Order.]
[bookmark: _Ref46762370][bookmark: _Toc51670926]OPPORTUNITY TO CONFER
[bookmark: _Ref50187785]Respondent may request a conference with EPA to discuss the Order, including its applicability, the factual findings and the determinations upon which it is based, the appropriateness of any actions Respondent is ordered to take, or any other relevant and material issues or contentions which Respondent may have regarding this Order, provided it submits a request to EPA for such a conference within [three] working days after receipt of the Order. Respondent is entitled to submit written comments or a statement of position, provided Respondent submits, within [three] working days after receipt of the Order, a notice to EPA of its intent to submit such written materials. 
[bookmark: _Ref50187767]If Respondent timely requests a conference, the conference must be held within [two] working days after Respondent’s request. Respondent and/or Respondent’s representative may appear at the conference. If Respondent timely notifies EPA of its intent to submit written materials, Respondent must submit those written materials within [five] working days after receipt of the Order, or, if a conference is scheduled, within [two] working days after the conference. EPA may specify in writing later deadlines for the conference or for submission of written materials. The conference is not an evidentiary hearing, does not constitute a proceeding to challenge this Order, and does not give Respondent a right to seek review of the Order. EPA will deem Respondent to have waived its right to the conference or to submit written comments if it fails to request or schedule the conference or submit comments within the specified time period(s). Any request for a conference or written comments or statements should be submitted to:
[Attorney]
[Office of Regional Counsel]
United States Environmental Protection Agency
[Address]	 
[Telephone]
[Email]
[bookmark: _Ref27997099][bookmark: _Toc51670934]EFFECTIVE DATE
[bookmark: _Ref50189779][bookmark: _Ref51340522]This Order is effective as of the later of: (a) [three] working days after Respondent or its designated representative receives the Order; (b) [three] working days after the conference scheduled by EPA under Paragraph 17, provided that Respondent timely requested a conference in accordance with Paragraph 16; (c) [three] working days after the deadline for submission of written materials if a conference is not scheduled in accordance with Paragraph 17, provided that Respondent timely notified EPA of Respondent’s intent to submit written materials in accordance with Paragraphs 16. If EPA determines that the Order should be modified based on the conference or written materials, EPA shall notify Respondent, within the applicable [three] day period, that EPA intends to modify the Order. The modified Order shall be effective [two] working days after it is received by Respondent.
[bookmark: _Toc51670935]NOTICE OF INTENT TO COMPLY
[bookmark: _Ref50391741][bookmark: _Hlk51821838][bookmark: _Hlk51332809]Respondent shall notify EPA [, using the form provided at the end of this Order and] in accordance with Paragraph 26, on or before the Effective Date, whether or not it intends to fully and unconditionally comply with the Order. Respondent’s failure to notify EPA of its intent to fully and unconditionally comply with this Order by the time the Order becomes effective shall be 1) construed as a denial of EPA’s request for access, and 2) as of the effective date under Paragraph 18 of this Order, treated as a violation of the Order.
[bookmark: _Toc20895495][bookmark: _Toc51670936]ENFORCEMENT
Any non-compliance with this Order is enforceable under Section 104(e)(5) of CERCLA, 42 U.S.C. § 9604(e)(5). Section 104(e)(5)(B) of CERCLA provides that a court may assess civil penalties for each day of noncompliance against any person who unreasonably fails to comply with an access order issued under Section 104(e)(5)(A) of CERCLA. As of the date of issuance of this Order, the statutory maximum amount is [insert dollar-figure set forth in 40 C.F.R. § 19.4] per violation per day. This maximum amount may increase in the future, as EPA amends its civil penalty amounts through rulemaking pursuant to the 1990 Federal Civil Penalties Inflation Adjustment Act (Public Law 101-410, codified at 28 U.S.C. § 2461), as amended by the 2015 Federal Civil Penalties Inflation Adjustment Act Improvement Act (Section 701 of Public Law 114-74)). The maximum amount to be applied to this violation will be set as the most recent maximum amount set forth in 40 C.F.R. § 19.4 as of the date that the U.S. District Court assesses any such penalty. Respondent may also be subject to punitive damages in an amount up to three times the amount of any cost incurred by the United States as a result of such failure to comply, as provided in Section 107(c)(3) of CERCLA, 42 U.S.C. § 9607(c)(3).
Nothing in this Order precludes EPA from taking any additional enforcement actions, and/or other actions it may deem necessary for any purpose, including the prevention or abatement of a threat to the public health, welfare, or the environment arising from conditions at the [Property/Facility/Site], and recovery of the costs thereof. 
[bookmark: _Toc16175925][bookmark: _Toc51670937]RESERVATIONS OF RIGHTS BY EPA
Nothing in this Order constitutes a waiver, bar, release, or satisfaction of or a defense to any cause of action which EPA has now or may have in the future against Respondent, or against any person or entity who is not a Respondent to this Order.
Nothing in this Order limits or otherwise affects the right of EPA to issue any other orders to, or take any other administrative or civil action against, Respondent or any other person under CERCLA which relate to the [Property/Facility/Site] or any other site.
Nothing in this Order limits or otherwise affects any right of entry held by the United States under applicable laws, regulations, or permits.
Nothing in this Order constitutes a decision on preauthorization of funds under Section 111(a)(2) of CERCLA, 42 U.S.C. § 9611(a)(2).
[bookmark: _Toc51670938]NOTICES AND SUBMISSIONS
[bookmark: _Ref50185986]All notices and requests specified in this Order (collectively, “Notices”) must be in writing and must be sent to EPA as specified below.
[bookmark: _Hlk51255699][Attorney]
Office of Regional Counsel
United States Environmental Protection Agency
[Address]	 
[Telephone]
[Email]
[bookmark: _Toc51670946]ADMINISTRATIVE RECORD
[bookmark: _Ref28000500]EPA has established an administrative record that contains the documents that form the basis for the issuance of this Order. It is available for review [Optional for time critical situations to allow for extra time to compile the documents relied upon or considered in making the decision to issue the access UAO. Timing to coincide with conference, if requested: will be available for review no later than five working days after receipt of this Order] by appointment on working days between the hours of ___ and ___ at the EPA offices in [insert Region-specific logistical information for review of the record]. To review the administrative record, please contact [insert name of Regional contact person] at [insert contact phone number and email address] to make an appointment. [Optional: A copy of the administrative record is also available for viewing at the [insert address where copy of the record is located]]. [Optional: An index of the administrative record is attached.]
[bookmark: _Toc20895500][bookmark: _Toc51670947]TERMINATION
 This Order is in effect, and Respondent shall provide access to the Property, from the effective date until EPA notifies Respondent that the activities for which access is needed are complete and access to the Property is no longer needed.

It is so ORDERED.

BY: ___________________________________	DATE: _____________________	
[Name and Title of Delegated Official]
Region [ ]
U.S. Environmental Protection Agency



[UNITED STATES ENVIRONMENTAL PROTECTION AGENCY REGION___

CERCLA Docket No_________

IN THE MATTER OF: [Insert Site Name and Location]


NOTICE OF INTENT TO GRANT ACCESS

I hereby notify the United States Environmental Protection Agency, in accordance with Paragraph 19 of EPA’s Administrative Order Directing Compliance With Request For Access, CERCLA Docket No. ____ (“Order”) that I will fully and unconditionally comply with the Order with regard to the Property identified in Paragraph 3 of this Order.


______________________________________________			__________________
Respondent									Date]
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[bookmark: _Hlk20907371]Instructions Regarding Automated Features

	FEATURE
	INSTRUCTIONS

	INSERTING TEXT COPIED FROM A DIFFERENT DOCUMENT
	Text copied from a different document will usually have embedded formatting codes. Pasting the text into your document will cause the formatting codes to be inserted as well, which will create unpredictable and frustrating formatting and numbering results. Therefore, ALWAYS use the “Paste Special” function to insert text copied from another document. Press Ctrl-Alt-V; in the pop-up menu, click “Unformatted Text” and “OK.” (You can also click the Home tab, Paste, Paste Special, Unformatted Text and OK.)

	INSERTING A NEW PARAGRAPH
	Click at the end of the ¶ immediately preceding the place where you wish to add the new paragraph, and press Enter. To change the new ¶'s outline level use (under the Home tab) the styles menu. For example, to change ¶12.b into ¶12.a(1), click in that ¶ and then (using the Home tab) click the "LVL 3" style. To change ¶13.a into ¶14, click in that ¶ and then (using the Home tab) click the “LVL 1” Style. Note that in consent decree models, the letters denoting each background paragraph must be manually updated.

	ADDING AN UPDATEABLE SECTION OR PARAGRAPH CROSS-REFERENCE
	(a) Click where you wish to insert a cross-reference; (b) Click the “References” tab, and, in the “Captions” box, click “Cross-reference;” (c) In the pop-up menu that appears, make sure the “Reference type” field contains “Numbered item” and the “Insert reference to” field contains “Paragraph Number (full context); (d) In the “For which numbered item” field” select the numbered item (section, paragraph. or subparagraph) you wish to cross-reference and click “Insert.”

	UPDATING THE CROSS-REFERENCES
	Press Ctrl-A (to select entire document); right click; in the pop-up menu, click “Update Field;” click “OK.” Note: If a numbered paragraph that has been cross-referenced elsewhere in the document is deleted, remove the obsolete paragraph cross-reference. Otherwise, when you update the cross-references, the following message will appear: “Error! Reference source not found.”

	UPDATING THE TABLE OF CONTENTS
	Right-click in the TOC, and in the pop-up menu, left-click “Update Field.” Or click in the TOC, press F9, click “Update Entire Table” and “OK.” If you have just added a new section heading, click “Update Entire Table” before pressing Enter.

	INSERTING A NEW SECTION HEADING
	Click in the text of the new heading and assign the “SECTION” paragraph style to the text by clicking the “Home” tab, and in Styles box, clicking the “SECTION” style button.) That will add the section number, change the numbering of later sections, and ensure that the new section will be referenced in the table of contents.

	CHANGING THE FONT
	Press Ctrl-A (to select entire document); right click; in the pop-up menu, click “Font;” in the “font” field, select a new font; click “OK.”




